
GETTING STARTED

1
In this chapter you’ll learn some important basics on your journey toward

recording. You should now be sitting in front of your computer with Pro

Tools installed and ready to go.

You’ll set up your first Pro Tools session and learn where your files are

located and exactly where you’re saving your sessions. It’s important to

have an understanding about how Pro Tools manages your files. You need

to know where your files are located and what hard drive you are record-

ing to—otherwise, you could have playback problems later.

Working in your new Pro Tools session, you’ll create your first track and

learn how to insert a plug-in. The first plug-in that you’ll create is a click,

or metronome. Using this metronome, you’ll learn how to use Pro Tools in

Bars and Beats mode—a timing reference that allows you to record your

music to a grid. This grid further allows you to edit entire song arrange-

ments and easily copy and paste tracks anywhere in your music. As you

work in Bars and Beats, you’ll begin to appreciate the importance of the grid

in creating professional music.

2
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3EXERCISE 1: START A NEW SESSION

The First Step
This may not be the most exciting chapter in the book, but it’s important that we cover the
basics so that you have a strong foundation to build your music on. When learning to drive
a car, you wouldn’t just get behind the wheel and head down the West Side Highway in New
York City without any instruction. So here at the beginning, try to have patience and faith in
our purpose. Learning all these exercises will pay off in the end.

EXERCISE 1:
Start a New Session

Before we can create a new song—or what Pro Tools calls a session—we need to open Pro
Tools. Where is it? Pro Tools is installed on your system’s hard drive, meaning the hard drive
that came installed in your computer. However, that’s not where you’ll want to save your
newly created project files.

Let’s walk through the process of finding and opening Pro Tools, starting a new file, naming
it, and saving it to your external audio drive.

1] Find Pro Tools. Mac users: Open your internal
hard drive, and open your Applications folder.
Inside there is a folder called Digidesign. Inside
that folder is another one called Pro Tools,
which contains the Pro Tools application. If
you haven’t already, drag the Pro Tools appli-
cation to your Dock.

Windows users: If you’re curious, open My
Computer or launch Windows Explorer. Open
your local drive (usually C:) and and then the
folder called Program Files. Inside that is the
Digidesign folder, which contains the Pro Tools
folder, which contains the ProTools.exe applica-
tion. When you install Pro Tools in Windows, a
desktop shortcut is automatically made for you,
so you should seldom need to access anything
in Program Files yourself.
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4 PRO TOOLS FOR MUSICIANS AND SONGWRITERS

Warning
For both Mac and Windows users, never take the Pro Tools application out of the Pro Tools folder.
The folder contains files that the Pro Tools application needs in order to operate.

“I never know where anything is on my hard drive!”
The most common confusion I encounter with new computer users is that they never fully grasp
where things are located. They don’t understand where they are saving their files, and so they
often don’t know how to find things again. 

If I asked you, “Where are your socks?” you might say, “in my dresser.” If you had to tell me where
to go to find your socks, you might say, “Go to my house, open the front door, open the bedroom
door, open the closet door, open the dresser drawer, and find my socks.”

File structure is a lot like that. The hard drive is your house. To find Pro Tools, for example, you
open the house’s front door—the hard drive. You open the bedroom door—the Applications (Mac)
or Program Files (Windows) folder. You open the closet door—the Digidesign folder. Then you
open the dresser drawer—the Pro Tools folder—and inside is exactly what you’re looking for.

In this book, the / character indicates the path you’ll take to find something. For instance, I’d explain
the path to the Macintosh Pro Tools folder this way: Hard Drive/Applications/Digidesign/Pro Tools.

2] Launch Pro Tools. In Windows, double-click
your Pro Tools desktop shortcut. On a Mac,
click Pro Tools in your Dock. On the Mac, the
menus at the top of your screen will become
the Pro Tools menus.

3] Start a new session. Under the File menu,
choose New Session. You’ll get a window, or
dialog box, full of choices. This window is ask-
ing you, “How do you want to work? Do you
want your song to be a 16-bit or 24-bit file?
Do you want to work with WAV files or AIFFs?”
The good news is that there are really no wrong
choices. Choose 24-bit, 44.1, AIFF (a very
common file type)—but don’t click Save yet.
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5EXERCISE 1: START A NEW SESSION

Sample Rate and Bit Depth, in Plain English
Digital photos are made up of tiny squares called pixels. A pixel is one dot on the computer
screen. The more pixels per square inch, the clearer the picture; also, the more pixels, the
larger the file. In photography, these pixels are measured in dpi, or dots per inch. So, a 72
dpi photo is a smaller file but has less detail than a 300 dpi file. Make sense?

If that makes sense to you, then sample rate will be simple. Instead of tiny pixels represent-
ing a piece of a picture, think of tiny samples or pieces of sound making up one second of
audio. The more samples per second, the clearer the sound; but again, more samples make
a larger file.

The 44.1 kHz setting simply means that your audio is being sampled or recorded 44,100
times per second. About 75 percent of my work is done at 44.1, but 48 kHz is very com-
mon. Higher sample rates such as 96 and 192 kHz are being used more and more these
days. There is no wrong choice. For important projects, world-class engineers suggest you
always work in the highest sample rate available; but they have fast computers and huge
hard drives. The higher the sample rate, the harder your computer will have to work, and
the more storage space you'll need for the tracks you record.

Bit depth is a little more complicated, but not much. Digital photos have shades of color,
and the shades are represented by bits. If you have only one bit to represent whether a pixel
is red or not, another bit for green, and another bit for blue, your photo will have three-bit
color resolution, with no subtle shades at all. The more bits we add, the more shadings we
can see in the picture. In audio as well, the higher the bit depth, the more accurate the audio
sound being represented digitally and, yet again, the larger the file.

A word about large files: Hard drives are so affordable these days that worrying about
using too much disk space is like worrying about where to place a broom in a four-car
garage. Most likely you will have more space than you need, so go for quality and don’t 
be miserly with disk space.
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6 PRO TOOLS FOR MUSICIANS AND SONGWRITERS

4] Name your session. This dialog box is also
where you name your song and tell the com-
puter where to save it. In the box where the
file’s name currently says Untitled, type
“Learning PT.” But then wait—don’t click Save
yet! This dialog box is also where you decide
how and where to save the files. Mac users: See
the blue triangle with the black arrow pointing
down? Click that. The arrow will now point up.
Windows users will see a drop-down menu when
you click on the drop-down menu at the top
of the box. This expands your view and shows
you every hard drive connected to your com-
puter, as well as the folders within your drives.
Whenever you see a Save window like this one,
get in the habit of expanding your window so
you can see where you’re saving your files.

5] Save your session. Make sure that you’re sav-
ing your session file onto your external audio
drive, which you should be able to select in
this dialog box. Click your external hard drive
to select it—and now you can click Save. 

Now you’ll see a big empty window.
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Note
NOTE: It’s possible that the window is not completely empty and you might see a click track in the window. (NewClick.Tif) NEW GRAPHIC If you do, this is because Pro Tools has a new Preference that automatically creates a click track when you create a new session. To turn this on or off, go to the Pro Tools menu and choose Preferences. Then click on the MIDI Tab. You will see under Basics, the option to turn on or off the option to create a click track. (NewClickPrefs.Tif) NEW GRAPHIC I leave mine on because as noted in the intro, I live and create to a click track for 90% of everything I do.




7EXERCISE 1: START A NEW SESSION

Note
Your computer’s default setup might “point to” the Documents folder, which is on your inter-
nal system drive. You don’t want to save your sessions here, because you would be recording
to your internal hard drive. Remember to always save sessions to your external audio drive.

“So many audio formats—which one should I use?”
The good news is, there’s really no wrong choice:

SDII is the Sound Designer 2 format and is the native audio format of Digidesign, which
makes SDII less compatible with some other programs. Some experienced audio users use
this format for specific technical reasons, but for the sake of compatibility, I would suggest
new users not choose SDII as a format.

AIFF stands for Audio Interchange File Format. It was initially created for Macs but has
become cross-platform over the years and is more and more prevalent. Being a Mac user
myself, I typically use AIFF as my default format, but I’ve recently been told by a few
prominent engineers that broadcast WAV is slowly becoming the format of choice.

WAV (Windows Audio/Visual) files are also called BWF or broadcast WAV files. Though
initially developed for Windows, this is also now a cross-platform format and very common
among Windows and Mac users.

So, where is your session? Before we get started making music, let’s find your new session
and see what has happened on your hard drive.

6] Hide Pro Tools. On the Mac, from the Pro
Tools menu, choose Hide Pro Tools. In Windows,
you can minimize the Pro Tools window or, if
Windows Explorer is running in the background,
simply click on it in the Task Bar at the bottom
of the screen to bring it to the front.

Note
On the Mac, I prefer to use Hide Pro Tools as opposed to Minimize, because you have to min-
imize each open window, one at a time. The Hide option, on the other hand, hides the entire
Pro Tools application regardless of how many windows are open.
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8 PRO TOOLS FOR MUSICIANS AND SONGWRITERS

7] Open your session folder. Open your exter-
nal hard drive, and you should see a folder
called Learning PT. 

Double-click on the folder to open it and see
what’s inside. 

When you make a new session, Pro Tools 
creates a folder with your song’s name. Inside
this folder, which contains your session file 
or song, Pro Tools creates four other folders,
called Audio Files, Fade Files, Region Groups,
and Session File Backups. You may also see 
a WaveCache.wfm file. This file helps redraw
your audio waveforms faster. 

◆ Everything you record in this song will be
created as audio files and put into the
Audio Files folder.

◆ Anytime you create a fade or a cross-fade,
it will go into the Fade Files folder.

◆ Anytime you create a Region Group (more
about these in a later chapter), that group
is saved into the Region Groups folder. 

◆ Last but not least is the very important
Session File Backups folder. Pro Tools will
make a safety copy of your song every 5 min-
utes and keep the last 10 versions. This is
extremely helpful if you forget to save and
the computer crashes. Simply open this
Backups folder and open the last saved
version. It’s also helpful if you accidentally
edit something incorrectly; you can always go
back to a previous version and work with that. 

8] Go back to Pro Tools. On a Mac, 
click the Pro Tools icon in your Dock. 
In Windows, maximize Pro Tools by click-
ing on it in the Task Bar at the bottom of
the screen. This brings Pro Tools back to
the front, with your big empty window.
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9EXERCISE 2: CREATE YOUR FIRST TRACK

Fasten Your Seatbelts
Now we’re back to our big, empty window. It’s empty because we haven’t created any tracks
yet. So, it’s time to do that. 

EXERCISE 2: 
Create Your First Track

1] Create an audio track. Under the Track menu,
choose New Track. A dialog box opens, asking
about the kind of track you want to create.

Tip
You’ll want to get used to using the keyboard shortcut for Track > New Track, which is
#+Shift+N for Mac, and Ctrl+Shift+N for Windows.

2] Choose the type of track. If you click each
menu option in the dialog box, you’ll notice
that you have a few choices in each field. You
can choose the number of tracks you want to
create, whether to record in mono or stereo,
and what kind of track it is. We’ll eventually 
try all of them, but to start out just create one
Mono Audio track, which is the default. Where
the menu currently says Samples, select Ticks.
(I’ll explain why later.) 

Click Create to create your new track.
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Note
Note: Changes since Pro Tools 7.3 and above.
Exercise 2 below shows you how to create a Click track from scratch. I think it’s important that you do this exercise so you know what is required to create a Click track. However, in a software update after Pro Tools 7.0, DigiDesign added a simpler way to create a Click. We’re going to learn both.
If you already have a click track in your session, let's delete it so you know how to create one if you happen to need to do that. To delete a track, click the track name (which will highlight it) (NameHighlight.tif) NEW GRAPHIC and then go to the Track menu and choose Delete. (TrackDelete.tif) NEW GRAPHIC
Click tracks are also created in that same Track menu. Simply go to the Track menu and choose the last option, Create Click. (CreateClick.tif) NEW GRAPHIC Hit the spacebar to play the song and make sure you hear the click playing. We’re going to change the click sound in another exercise.
Note: If you don’t hear anything, a common mistake of new users is to have your speakers connected to the computer instead of the Pro Tools interface. Your speakers should be connected to the output of your Pro Tools interface, not the computer. Your headphones should also be plugged into the Pro Tools interface. All sound going in and out is going through your interface, not your computer.




10 PRO TOOLS FOR MUSICIANS AND SONGWRITERS

The Mix and Edit Windows
There are only two prominent windows in Pro Tools. One is the Mix window, which will
act as your mixing console, and the other is the Edit window, which you will use to edit
your music. To toggle between the two windows, use the keyboard shortcut Command+=
(Mac) or Ctrl+= (Win).

If you’re going to use Pro Tools a lot, an ideal solution is to have two monitors and put the
Mix and Edit windows each on its own monitor. You can also resize the two windows to 
fit on the same screen. Below I’ve put the Edit screen on the left and the Mix window on
the right.

If for some reason you don’t see both windows automatically when you open a session,
you can turn them on by selecting Show Mix or Show Edit in the Window menu. 
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11EXERCISE 2: CREATE YOUR FIRST TRACK

3] Rename the fader. Now that you’ve created
your first track, you’ll see your first fader in the
Mix window. The fader is at the bottom of a
vertical column called a channel strip. The new
channel is named Audio 1. Notice the same
name in the Edit window.

To rename the track (in Pro Tools, tracks and
channels are basically the same thing), double-
click the track name Audio 1 in either the Mix
window or the Edit window. A small window
opens. There, type “Click” for the new name
and then click OK.

So, our first track is going to become a click
track, also known as a metronome.
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12 PRO TOOLS FOR MUSICIANS AND SONGWRITERS

EXERCISE 3: 
Add Your First Plug-in

When someone says ”plug-in,” you probably think of an effect or a compressor or EQ—but
instruments are plug-ins, too, and since a click uses a sound, it is considered an instrument
plug-in. We’re going to work with other plug-in instruments such as synths and pianos later
in the book, but for now we’re going to use a plug-in instrument that generates a click
sound, so you’ll have a metronome to work with.

1] Turn on Bars and Beats. First, make sure that
Pro Tools is set to display in Bars and Beats.
Under the View menu, go to the Main Counter
submenu, and if Bars and Beats is not
checked, select it to turn it on.

2] Find Inserts and Sends. In the Mix window
at the top of the channel strip, you’ll see five
little buttons with tiny up and down arrows.
This section of the channel strip is called Inserts.
Below that are two identical-looking sections
called Sends. For now, we’ll concentrate on
Inserts only. This is the place where you put,
or insert, your click instrument (and eventually
your cool effects plug-ins and instruments).

Inserts

Sends
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13EXERCISE 3: ADD YOUR FIRST PLUG-IN

3] Insert a click. At the top of your channel strip,
click on the top Insert arrow, which reveals a
pull-down menu. Choose Plug-in, and notice
that Pro Tools categorizes all the plug-ins
according to what they do. As I mentioned,
the Click plug-in is considered an instrument,
so scroll down to Instrument and choose Click.

4] Open the Transport window. Under the
Window menu, choose Transport.

Tip
The Transport window is not just for playing and record-
ing—it’s also where you can set your tempo, turn the
metronome on and off, and set up pre-roll and post-roll.

5] Turn on the metronome. On the far-right
side of the Transport window you’ll see a
metronome icon. Make sure that it’s highlight-
ed, which indicates that the metronome is on.
You can also turn it on and off by pressing 7
on your numeric keypad.
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14 PRO TOOLS FOR MUSICIANS AND SONGWRITERS

6] Play the click. Now it’s time to hear our click
track. Press the spacebar to play, and press it
again to stop. (You can also click the play and
stop buttons in the Transport window.)

Note
If your Transport window looks different from what you
see illustrated here, or if some icons are missing from your
display, go to the View menu and choose Transport to
enable everything.

EXERCISE 4:
Change the Click Sound and Volume

When you first play the Click plug-in, you’ll hear the default click sound, which is a 
computer-generated sound that I find to be a bit sterile. Let’s make it more interesting.

We’re going to change the click sound to something more musical. Then we’ll explore some
of the plug-in’s other options.

1] Open the plug-in: To see the Click plug-in
window, click the Click insert on your channel
strip in the Mix window. The plug-in window
opens.
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15EXERCISE 4: CHANGE THE CLICK SOUND AND VOLUME

2] Choose a new click sound. Click Factory
Default, and you’ll be given a menu of sounds
to play for the click track. I use Marimba 2 for
most things.

3] Audition the click. Now press the spacebar to
play. You should hear a new click sound.

Try changing to a few other click sounds to
become familiar with the choices.

4] Change the accent. Notice how the first beat
is louder than all the rest? This is because
some people like to work with Beat 1 accent-
ed, or louder than the other three beats.

In the Click plug-in window, you’ll see two
small sliders labeled Accented and Unaccented;
these control the volume level. The first slider
represents the volume of Beat 1, and the other
slider represents the volume of Beats 2, 3, and
4 (if you’re working in the default meter, 4/4). 

If you try to set these fader levels at the same
volume, you’ll find it’s not very easy to be
exact. One quick way to put all beats at the
same volume is to hold down the Option key
(Mac) or the Alt key (Win) and click both slid-
ers. The levels will go to 0, and both sliders
will be at the same level.
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16 PRO TOOLS FOR MUSICIANS AND SONGWRITERS

Tip
Clicking while holding the Option key (Mac) or the Alt key (Win) sets most everything in 
Pro Tools to the default setting. Try it: Go to the Mix window and move your fader’s volume
slider up or down. Now Option+click (Mac) or Alt+click (Win) on the fader to reset it to 0.

5] Save your metronome setting. Click the two
tiny up and down arrows to the left of the
name Marimba 2, and choose Save Setting As.
Name it “My Click.”

Now that you’ve saved this setting, the next
time you create a song, you can open your
saved Click instrument by choosing My Click
from the menu.

6] Save the session. Under the File menu,
choose Save. Or get in the habit of using the
shortcut Command+S (Mac) or Ctrl+S (Win).
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EXERCISE 5:
Change the Tempo

Now that you’ve created your own click, you’ll want to be able to use it at different tempos.

1] Open the Transport window. The Transport
window may still be open. If it’s not, select
Window > Transport again. Or use the short-
cut Command+1 (Mac) or Ctrl+1 (Win), using
the 1 on your numeric keypad.

2] Turn off the Conductor. See the little icon of
the man conducting in the Transport window?
That’s the Conductor, which you’ll learn more
about in Chapter 10. Click the Conductor icon
to turn it off for now.

Metronome

The Conductor

3] Set a manual tempo. When your Conductor
is off, Pro Tools uses the manual tempo set-
ting. At the far right in the Transport window
is the Manual Tempo field.

The default tempo is 120 BPM. Type your
desired tempo into this field—100 (for 100
beats per minute), for example—and press
Return/Enter.

Warning
You must press Return or Enter. If you don’t, the tempo
will not change.

Tempo Field
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4] Play the click. Press spacebar. Your click track
should be playing more slowly now.

Setting the Tempo with a Finger Tap
If you’re sitting with your guitar or piano and you have a song but no idea what the tempo
is, it’s very handy to be able to tap your own tempo. To enter your own tempo by tapping,
first make sure the Conductor is turned off. Move the cursor to highlight the Tempo field,
and then repeatedly tap the T key on your keyboard to the beat of your song. Watch the
Tempo field and see the number change as you tap. 

EXERCISE 6:
Get to Know the Ruler Timeline

Open the Edit window and maximize it to make it larger. At the top is a long rulerlike sec-
tion called the Timebase Ruler (or Ruler view), which displays your song from beginning to
end, in various measurements. You can completely customize the selection of rulers you see
on the screen, so let’s first get to know which ones we need; then we’ll remove the ones we
won’t be using. 

Working with music, you’ll mostly use the Bars and Beats, Minutes and Seconds, Markers,
Tempo, and Meter rulers.

◆ The Bars and Beats ruler shows your song measured and divided into bars made up of
beats. This allows you to keep everything in sync as you edit arrangements quickly and
easily. Looking at the Bars and Beats ruler, it’s easy to tell that the chorus starts at Bar
32, or that the song ends at Bar 99.

◆ The Minutes and Seconds ruler helps you keep tabs on your song’s length, or at what
point a certain section of a song (such as a verse or chorus) begins and ends. I use the
Minutes and Seconds ruler to make sure that my song isn’t running too long, or that I
don’t have two minutes of intro before the first verse, and so forth. 

◆ With the Marker ruler, you can label each section of the song with names like Verse 1,
Chorus 2, or Bridge, so it’s easy to know where you are at all times.

◆ The Tempo ruler displays the tempo of your song, and any changes to the tempo—
in this case, 100 BPM.

◆ The Meter ruler displays the meter (or time signature) of your song, such as 4/4 or 6/8,
and allows you to insert meter changes.
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1] Choose your rulers. Go to the View menu,
and choose Rulers. This is where you tell Pro
Tools which rulers you’d like to see in your song.

2] Turn off what you don’t need. In the Rulers
submenu, click to turn Meter on and Samples
off. Meter should be checked, and Samples
should not. (The Samples ruler is for precise,
microscopic editing, which we won’t be doing.)

These are your Ruler tracks, aka “Ruler Views”

The Tempo ruler

In this exercise, you’re going to turn off the Ruler views you don’t need and get them out of
your way, because every inch of screen space is important in using Pro Tools. The more room
you have to work with on screen, the better. 

Wrap Up
So you’ve made it through the first chapter. From here, you have a few more back roads to
cover before you head down the highway—but at least you’re behind the wheel and starting
to cover some serious ground. Hang in there; it only gets better from here.
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